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The previous activity involved merging information from a database.  We will now look at how to merge data from an Excel 
spreadsheet.  Although it is common to use a spreadsheet to hold simple text such as address information, they are really intended 
to hold numbers and perform calculations.  This task uses a spreadsheet designed to hold test scores. 
 
 

 

Task 1 – Setting Up the Spreadsheet 
 

a. Open a blank Excel spreadsheet and enter the data below.  All the numbers in italics (and shaded) should be 
calculated cells.  The percentage columns are not formatted as percentages as this complicates the merge. 
 
Note - it is important when using spreadsheets to have a row of headings, or the merge fields can be very confusing. 

 
 
 
 
 
 
 
 
 
 
 
 

 
b. Save the spreadsheet as ‘Test Scores’.  Remember the location of your spreadsheet before closing it. 

 
 
 

Task 2 – Identifying the Data Source in Word 
 

Work in a new Word document.  This process is virtually identical to the one used in the last activity.  The only difference 
is the point at which you select the table from your spreadsheet.  Unless you chose not to work in the default Excel 
worksheet, then simply select ‘Sheet1$’.  
 

 
 
 
 
 
 
 
 
 
 

Task 3 – Inserting Merge Fields 
 

Design a scores table like the one shown below.  All the 
information with grey background is merged from the 
spreadsheet.  Save as ‘WA09 - Test Scores Merge’.  

 
 

 
 
 
 
 
 
 

 
Note: to display marks and averages with a set number of decimal places, you have to use the FIXED function in Excel. 
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Excel offers a whole range of statistical functions.  You should have previously used the functions MAX, MIN and AVERAGE.  We are 
now going to look at some of the other commonly used functions. For example: 
 

• MODE, MEDIAN The mode and median of a set of data. 
• COUNT, COUNTBLANK, COUNTIF Count the cells that fulfill the given criteria. 
• LARGE, SMALL Find the 7th largest, or the 4th smallest value etc. 
• STDEV Standard deviation in a set of data. 
• RANK The value occupying a certain rank in the list. 
• QUARTILE The number one quarter of the way through the set etc. 

• PERCENTILE The number 90% of the way through the set etc. 
 
 
The spreadsheet below uses a number of statistical functions to analyse a set of data (present in columns B and C). 
 

 
 
 
 

Task 1 – Data 
 
Ignoring the blank cells, write out the data in order, starting with the smallest, in a table like the one shown below. 
 

Rank 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 
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Note – The way Excel calculates its quartiles and percentiles is fairly complicated.  It will not be covered here. 
 

 

 

Task 2 – Using the Functions 
 

Recreate the spreadsheet shown above.  Make sure that all the statistical values are created using formulas that refer to the 
data in the range B3:C13.  
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A relational database is powerful because it allows you to gather information together in a query, form or report.  For example, the 
report below is taken from a sample database.  It is compiled by taking information from four different tables. 
 
 
 
 
 

 
 
 
 
 
Before information from numerous tables can be collated like this, it is necessary to link the tables together through relationships.  
We have previously discussed how identical fields play a part in a relationship.  We now need to look at the other aspects of creating 
our relational database. 
 
 
 

Types of Relationship 
 
When creating a relationship between two tables, Access has to understand what type of relationship it is going to be.  The three 
possibilities are as follows: 
 

1. One-to-Many relationships 

2. Many-to-Many relationships 

3. One-to-One relationships 

 
 
One-to-Many Relationships  
These are used when one record in the first table matches a number of records in the second table.  For example, each customer in 
the ‘Customers’ table may have a number of orders in the ‘Orders’ table.  This is a ‘one-to-many’ relationship. 
 
 
Many-to-Many Relationships  
These are used when each record in the first table can match a number of records in the second table and each record in the second 
table can match a number of records in the first.  Imagine our company bought a single product from a number of different 
suppliers.  Each record in the ‘Suppliers’ table could match a number of different products in the ‘Products’ table, but each product in 
the ‘Products’ table could also match a number of suppliers.  This is a ‘many-to-many’ relationship. 
 
Note – ‘many-to-many’ relationships can cause problems.  In the example above, you would have repeated information about the 
same product in the ‘Products’ table.  This is inefficient and leads to errors.  Database designers will usually find ways to solve the 
problem, using an extra table and two ‘one-to-many’ relationships.  Think through how you could solve the problem above. 
 
 
One-to-One Relationships  
These are rarely needed.  They are used when each record in the first table matches no more than one record in the second table, 
and each record in the second table matches no more than one record in the first.  For example, you may want to send Christmas 
cards to the top 10% of your customers.  As the Christmas card list is a bit of a one-off, you may decide to keep this information in 
a separate table.  This also means that you don’t have blank fields for all the customers who aren’t going to receive a card.  In this 

case, each customer in the ‘Christmas Card’ table would match the same customer in the ‘Customers’ table.  This is a ‘one-to-one’ 
relationship. 
 

Shipping address 

from the Customers 

table 

Invoice details from 

the Orders table 

Product names from 

the Products table 

Billing address 

from the 

Customers table 

Individual purchases 

from the Order 

Details table 
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Task 1 – Types of Relationship 
 
Decide whether each of the following relationships would be ‘One-to-Many’, ‘Many-to-Many’ or ‘One-to-One’. 
 

a. Orders from the ‘Orders’ table relating to the individual purchases in the ‘Order Details’ table. 

 

b. Products from the ‘Products’ table relating to the products in the ‘Order Details’ table. 
 

c. Suppliers from the ‘Suppliers’ table relating to the suppliers in the ‘Products’ table. 

 
 

 

Task 2 – Creating a Relationship 
 
To set up the relationships, we use a schema.  A schema is a diagrammatic representation of our database. 
 

a. Open your ‘Relational’ database containing the five tables created earlier. 
 

b. Open the ‘Database Tools’ tab and click on ‘Relationships’.  Now click on the ‘Show Table’ button. 

  

c. Double-click on each of the five tables in the ‘Show Table’ window.  Close the window when all tables have been added to 
your schema.  You can select and delete any tables added twice by mistake. 

  
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

d. Layout the tables in the order that they are to be linked i.e. Customers – Orders - Order Details – Products - Suppliers.  
You can increase the size of the window if necessary. 

  

e. Click on the ‘CustomerID’ field in the ‘Customers’ table and drag the cursor over the ‘CustomerID’ field in the ‘Orders’ 

table.  When the mouse button is released, Access will open a window displaying the relationship that it presumes you 
want to create. 

 
 

  

  
 
 
 
 
 

f. The window should display the ‘CustomerID’ field in both tables.  If it doesn’t, then you have not dragged the field over 

correctly.  The correct fields can be selected from the drop-down lists. 
  

g. Click the ‘Create’ button.  A line will appear between the two tables.  The relationship can be edited by right-clicking on the 
line and selecting ‘Edit Relationship’.  It can be deleted by right-clicking on the line and selecting ‘Delete’. 

 

The primary 

key in the first 

table 

Enforce 

Referential 

Integrity 
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relationship 
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Task 3 – Completing the Relationships 
 
We have created one relationship in our database.  It is now necessary to repeat this process for the other relationships.  
Remember, in each case: 

 

a. Drag from the primary key field in one table to the identical field in the other. 

 

b. Check that the correct fields are involved. 
  
Note – in this case, all relationships are created by dragging towards the centre in the schema. 

 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

Task 4 – Referential Integrity 
 
When creating relationships between tables, it is possible to set referential integrity.  Referential integrity is essentially a set of rules 
that the database uses to make sure that a relationship is maintained.  For example, each of the orders placed in our ‘Orders’ table 
comes from a customer.  Referential integrity will stop an order being placed if the customer is not in the ‘Customers’ table. 
 
Referential integrity can also stop data being deleted accidentally.  For example, each product in the ‘Products’ table will have been 
supplied by someone in the ‘Suppliers’ table.  Referential integrity will stop a supplier being deleted if they are still linked to products 
in the ‘Products’ table. 
 
Referential integrity can only be used under certain conditions.  These are as follows: 

• the field in the first (or primary) table is the primary key in that table.  

• the related fields in both tables have the same data type. 

 
When the ‘Enforce Referential Integrity’ option is selected for a relationship, you are limited in the way that data can be entered.  
For example: 

• a supplier must be entered before the products they supply. 

• a customer must be entered before an order can be placed by them. 

• an order must be created before the details can be recorded in the ‘Order Details’ table. 

• all products provided by a particular supplier must be edited or deleted before removing the supplier. 

• the primary key in the first table cannot be changed whilst related records exist in the second table. 

 
Note – Access provides a ‘Cascade’ facility to override these limitations and still preserve referential integrity.  For example, if you 
change a ‘CustomerID’ in the ‘Customers’ table, it will change the ‘CustomerID’ for that customer in each related record in the 
‘Orders’ table.  However, because these changes can’t easily be reversed, it is suggested that this facility is generally not used.  

 
 
Task – edit each of the relationships so that referential integrity is enforced.  Symbols above the join line in the ‘Relationships’ 
window will appear.  These indicate the type of relationship: one-to-one, one-to-many etc.  The ‘1’ indicates ‘one’, while the infinity 
symbol (∞) indicates ‘many’.  All our relationships should be one-to-many. 
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Objects are the basic elements of a publication.  They include text boxes, tables and images.  Although they do different things, all types of 
objects have a number of functions in common, such as moving and resizing.  Also, many of the objects are identical to those used in other 
MS Office applications, so we won’t go in to too much detail about them here.  

 
 

 
Objects can be created from the tools found in the ‘Insert’ tab in the ribbon.  

 
 

 
 
 
 
 
 

 
 

  

Task 1 – Introducing the Different Objects 
 

a. Open your menu and select the second page (the one with the menu items and prices). 
  

b. Click on ‘Insert / Pages / Page’.  A new page, numbered ‘3’, will be created.  We will use this ‘test page’ to look at a 
variety of objects before deciding what to use in our menu. 
 

c. Click on ‘Insert / Text / WordArt’ and select a WordArt style.  Type the text “Test Page” in the box and click ‘OK’.  
With the WordArt selected, open the ‘WordArt Tools - Format’ tab and try some of the styles and effects available.  Place 
the WordArt in the top left of your page. 
 

d. Click on ‘Insert / Text / Draw Text Box’ and draw a rectangle on the screen under the WordArt.  Type the text “This 
page has been created to test the objects available in Publisher.  It will not be printed.”  Format the text. 
 

e. Click on ‘Insert / Tables / Table’ and select 3 columns and 3 rows.  Type the numbers 1-9 in the cells.  Format the 
text using the tools in the ‘Home’ tab.  With the table selected, open the ‘Table Tools - Design’ tab and use the ‘Borders’ 
options to place a solid border around each cell.  Select all the cells, open the ‘Table Tools - Layout’ tab and align the 
text ‘Center’ using the ‘Alignment’ tools. 
 

f. Click on ‘Insert / Illustrations / Online Pictures’ and find an image to use.  Place this below your table. 
 

g. Click on ‘Insert / Illustrations / Shapes’ and select ‘Explosion 1’ from the ‘Stars and Banners’ group.  Draw a 
rectangle on the screen below your image to create this shape. 
 

h. In the remaining space on your page, add a design element from the ‘Page Parts’ menu, a calendar (reduce in size once 
created), an advertisement and something from the ‘Borders and Accents’ menu. 
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Task 2 – Manipulating Objects 
 

Tasks such as moving, resizing and copying are common throughout the whole range of objects created.  We will look at these 
tools using the image and shape, but they are available for all objects.  

 
a. Open your test page and select the image.  The circles and squares around the edge are called 

handles.  They mark the edges of an object and are used for resizing.  The top circle is used to 
rotate the object. 
 

b. Press the arrow keys on the keyboard.  You should be able to ‘nudge’ the image around in the four 
directions.  Hold the ‘Shift’ key down whilst nudging and it will jump further on each keystroke.   
 

c. Hold the ‘Shift’ key down and drag the ClipArt around.  The ‘Shift’ key locks the movement to the 
vertical and horizontal. 
 

d. Hold the ‘Ctrl’ key and drag the image once more.  You should find that a copy of the image is 
created.  You can select and delete the copy. 
 

e. Nudge the image down so that it overlaps the explosion shape below.  You should find that the one 
created most recently (the explosion) is on the top layer, obscuring the image underneath.  Select 
the explosion and click on ‘Home / Arrange / Send Backward / Send to Back’.  It should now 
lie in a layer below the image.  (This tool is also available in the ‘Picture Tools – Format’ tab). 
 

f. Hold the ‘Shift’ key down and select both the ClipArt and the explosion shape.  Click on ‘Home / 
Arrange / Align / Align Right’. 
 

g. With the two objects still selected, click on ‘Home / Arrange / Group’.  They will appear to merge 
and can now be treated as one object.  Nudge the object as before to check that this is the case. 
Note: the object can be ungrouped whenever individual manipulation is required. 
 

h. Hold down the ‘Shift’ key and drag the top left handle outwards.  You should find that the object 
increases in size but keeps to scale, whichever way you drag.  Now hold the ‘Ctrl’ and ‘Shift’ keys 
down and drag the handle again.  What is the difference this time?  Try both processes without the 
‘Shift’ key.  In this case, the fixed scaling is lost. 
 

i. Hold the ‘Shift’ key down, then click on the top circle and drag it sideways.  The image should 
rotate.  Try without the ‘Shift’ key to see the effect it is having?  What happens if you rotate the 
object with the ‘Ctrl’ key held down? 
 

j. Save your publication. 
 

 
 

 Task 3 – Distributing Objects 
 

a. Make a copy of your combined object.  Ungroup your copy and delete 
the shape so that you are left with your original image again.   

 
b. Reduce the size of the image and make three copies of it, placing all 

four reasonably close together but randomly arranged in a space on 
your page (make some more space if necessary). 

 
c. Hold down the ‘Ctrl’ key and select all four images together. 

 
d. Open the ‘Home / Arrange / Align / Align top’. 

 
e. Click again on the ‘Align’ icon and select ‘Distribute Horizontally’. 

 
f. Use the ‘Bring Forward’ and ‘Send Backwards’ tools to arrange the 

stack order, so that the images are front to back as you move left to 
right. 

 
g. Group the four images.  Save your work. 

 
 

 

Task 4 – Manipulating Drawing Objects 
 

Many drawing shapes can be further manipulated by moving the small yellow handles. 

 
a. Create a ‘Right Arrow’ using the ‘Shapes’ menu in the ‘Insert’ tab.  Fill with colour. 
 
b. Copy the arrow then manipulate the copy using the yellow handle.  Repeat this 

twice more, creating and arranging arrows like those shown on the right.  Save 
your work. 

 
 

 


